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实验准备 

1. 开发板 

2. 参考资料和源代码下载 

邸老师主页：http://www.dizhixiong.cn/class5/ 

 

3. 工具：Vivado，CDK（百度查找下载方法）     

Vivado：可以下载最新版，也可以下载 2018 版，占内存小； 

CDK： 

http://www.dizhixiong.cn/class5/
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4. 下载器： 

⚫ FPGA USB Cable（连接 Vivado 和板子，将 wujian100 下载到板子上） 

⚫ Clink  (调试器，用来连接 CDK 和开发板，下载 LED、SD 卡等测试程

序到开发板) 

⚫ USB 转串口（用来读串口数据） 

5. 邸老师主页的源代码相关文件有： 
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实验一：Wujian100 的仿真 

实验目标 

Wujian100_open 是阿里平头哥在 Github 上开源了 RISC-V 项目。本实验主要完

成在 Linux 环境下实现 Wujian100 的仿真。 

实验步骤 

1.下载官方代码 

无剑的仿真需要 Linux 环境，这里使用的是 MobaXterm 的 SSH 终端连接

Ubuntu 的工作站。 

 

建一个文件夹，作该为项目的文件夹：mkdir wujian 

切换工作目录到该文件夹下：cd wujian 

将 Wujian100 的代码从 github 上下载到该文件夹下: git clone http://github.com/T-

head-Semi/wujian100_open.git 

 

 

2.下载工具链： 

在平头哥的官网上下载工具链。版本可能不同，下载最新的就好。 

地址：https://occ.t-head.cn/community/download?id=3913221581316624384 

http://github.com/T-head-Semi/wujian100_open.git
http://github.com/T-head-Semi/wujian100_open.git
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创建工具链文件夹：mkdir riscv_toolchain 

切换工作目录到该文件夹下：cd riscv_toolchain 

 

将下载好的工具链压缩包放到该文件夹下，这里直接拖拽复制，将文件由

Windows 本机上传到了该 Ubuntu 系统的工作站上。也可用 cp 复制命令复制到

文件夹下。 

 

解压文件：tar -zxvf riscv64-elf-x86_64-20210512.tar.gz 

 

等待解压完成。 
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3.修改脚本： 

由于原本的脚本是 setup.csh 文件，在 bash 环境下有一些不兼容的地方。这里重

新建立一个 setup.sh 脚本，如下图所示，放入 wujian100_open/tools 目录下(原

setup.csh 目录) 

 

Cd 到 wujian100_open/tools 目录下： 

 

这里也是将 Windows 本机的 setup.sh 文件上传到工作站上。 
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输入： source setup.sh 

 

 

4.运行仿真 

进入到 wujian100_open/workdir 目录下运行仿真：cd ../workdir 

开始运行仿真： ../tools/run_case -sim_tool iverilog ../case/timer/timer_test.c 

 

 

仿真成功。 

5.仿真波形的查看 

在运行完仿真后，在 wujian100_open/workdir 目录下会生成 test.vcd，如下图所

示。VCD 文件包含了信号的变化信息，就相当于记录了整个仿真的信息，我们

可以用这个文件来再现仿真，也就能够显示波形。 

 

因为 VCD 是 Verilog HDL语言标准的一部分，因此所有的 verilog 的仿真器都能

够查看该文件。 

这里介绍用 Modelsim 软件查看波形。将生成的 test.vcd 文件传输到 Windows 主
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机上，存放于 E:/Project/wujian100_sim 文件夹下。 

 

打开 Modelsim 软件。 

点击 File->Change Directory，将目录更改至 test.vcd 的目录下；或者直接在在

Modelsim 中的控制台输入：cd E:/Project/wujian100_sim 直接定为到该文件夹下。 

 

因为 Modelsim 只支持.wlf 波形文件，所以需要做格式转换。 

在 Modelsim 中的控制台输入：vcd2wlf test.vcd test.wlf 
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在 Modelsim 中打开 test.wlf，点击 File->Open->test.wlf 

 

在 object 标签中选取需要观察的信号添加到波形窗即可。 
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实验二：Wujian100的 SoC实现 

实验目标 

主要完成 wujian100 SoC 在 FPGA 上的部署。学会使用 Xilinx vivado 工具。 

 

实验步骤 

1. 把 wujian100 用 Vivado打开 

1) 创建工程： 

 

 

next 后添加 verilog 源码： 
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点击 next 后添加 xdc 文件 
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1) 选择开发板 
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2) 文件添加进来后，VIVADO 会自动识别、编译、分析，VIVADO 分析文

件中的错误，用红色波浪线标识（错误原因是没有识别出头文件，将这

四个文件类型改为头文件类型即可） 

 

3) 调用时钟 IP 
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2. 根据 perfv 开发板手册添加管脚约束 

详细见文件“xdc 的更改”. 

3. 综合工程，综合无误后进行 bit 流下载 
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可能出现 error-某某 module 未找到，注释掉这个 module 就行 

 

综合结果如下： 

 

 

  

如果生成 bit 流时出现“没有约束的逻辑端口的错误”：可以添加 tcl 文件消除

错误 
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17 

 

 

4. 下载到开发板上 

1) 接口连接电脑和开发板 

 

2) 固化 FLASH： 
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显示 5 表明 wujian100 已经下载到了开发板里，并且上电复位就可以运行。 
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实验三：I/O口与 SD卡读写实验 

实验目标 

（1）在 wujian100 SoC 在 FPGA 上完成部署之后，通过设置该 SoC 的 I/O 引脚

为高电平或者低电平，观察 LED 的亮灭，学会使用 E902 的 I/O。 

（2）学会使用 E902 处理器读写 SD 卡，需要 SD 卡和 SD 卡的拓展板。 

注意：SD 卡相关功能需要 Pref 的 SD 卡拓展板，借插口如下。SD 卡的程序和

LED 的程序是一起的，所以一起就可以测试。（不要热插拔） 
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实验步骤 

1. 连接电脑和 wujian100 

Clink 与 PMOD 连接： 
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如下对应关系： 

 

2. 连接 USB 转串口下载器和开发 
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3. 编译调试 
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显示出来了 E902 才可以进行下一步，没有显示出来可以去查一下 PMOD 和

CLINK 的连接是不是错的，或者没连上。 

4. CDK 的串口窗口 
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5. 下载程序 
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或者用这两个： 
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6. 复位后就会正确现象是灯闪烁，以及 

       

 

表明 SD 卡读取正确，可以在 Debug 调试界面查看寄存器中具体的值。 
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实验四：RT-thread Nano OS移植 

实验目标 

RT-thread Nano 是一种实时的嵌入式操作系统。RTT 的代码也包括在从邸老师主

页下载的 Nexysvideo_wujian100-main 文件里，这个文件里有着 IO 实验和 RTT

移植要用的所有代码，只需要在 CDK 里打开工程就行了。 

 

（邸老师主页：http://www.dizhixiong.cn/class5/） 

 

 

实验步骤 

1、在 CDK 中打开串口面板 

http://www.dizhixiong.cn/class5/
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2、设置串口 

 

3、添加针对 E902处理器移植的 RTT nano代码修改版 
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实验五：在总线上挂载 IP 

实验目标 

Wujian100 中有留有许多 dummy 模块，可供用户自定义设计。本文档使用 AHB

总线上的 Dummy0 模块，通过写寄存器的方式控制 RGB LED 外设。 

 

 

 

本次实验在 vivado 中建立自己的 IP，IP 为 AXI4 接口。基于三色 LED 灯的控制

需要 9 位，这里用 32 位寄存器 0 的低 9 位作为控制输出。挂载 IP 到 wujian100、

实现与验证功能。 
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实验步骤 

一、 建立 Block Design 

Wujian100 软核为 AHB 总线，VIVADO 支持 AXI 总线 IP，需要用到 AHB-Lite 

to AXI Bridge 转接模块。 

点击 Create Block Design，输入设计名，打开 Block Design 界面。 

 

点击加号添加 IP，搜索 AHB-Lite to AXI Bridge，选择双击添加。 

 

点击模块，按图标或 Ctrl+T 引出端口。该桥接模块作为 AXI 主机，自定义 IP

为 AXI 从机。 
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后面需要对源文件中的端口名进行修改，这里将后缀去掉，待会编辑的时候方

便一点 

 

创建自己的 AXI IP 核，自定义 AXI IP。点击 Tools->Create and Package New IP。 

 

点击 Next。 
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选择创建 AXI 外围的 IP，点击 Next。 

 

可对 IP 自己命名，写描述。 
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桥是 master ，我们就创建 slave 的模式。如下图，点击 Next。 
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点击左侧 IP Catalog，打开 IP 管理器，看到刚才添加的 myio→ 右击 myio_v1.0 

→ Edit in IP Packager 选项，单击 OK，此时系统会自动打开另一个 Vivado IDE

来对用户 IP 核进行编辑。 

 

在本模块中，设定有 4 个寄存器，每个寄存器位宽 32 位。这里通过往寄存器中

写数据，来达到控制输出端口电平，从而控制三色灯的输出。将输出端口连接

寄存器寄存器。 

双击进入 myio_v1_0_S00_AXI，设计文件里面有用户代码区域。 

根据需求增加端口声明和添加用户信号。这里增加一个 output [31:0]myio 用于

控制三色灯。 

 

根据需求，添加用户逻辑代码。这里增加 assign myio = slv_reg0; 将输出连上寄

存器 0。 
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双击击进入 IP 的顶层，增加 output [31:0]myio 

 

例化中增加.myio(myio), 

 

将更改刷新。切换到 Package IP-myio 窗口，单击如图所示链接，对刚才修改过

的顶层文件进行更新。 
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重新打包一下 IP 
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现在可以使用这个 IP 了，将 IP 添加进 Block Design。 

 

 

但它们的 AXI port 仍然有点差异，连接不上，需要加一个互联的 IP 

 

添加 AXI Interconnect 模块 



40 

 

 

双击打开 AXI Interconnect 模块，Slave 和 Master 的接口都为 1。 

 

可以鼠标拖拽，连接端口 

 

直接点击自动连接 
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自动连接所以，点击确定。 

 

在自动布线后，出现了一个新的模块连接 rst 信号，这里把它删掉，自己手动连

接。 
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将 reset 信号手动连好。 

 

 选中 myio 模块，ctrl+t 引出输出 
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与之前一样修改名称，改为 myio 

 

分配地址。去 Adress Editor 界面，找到 myio_0，右键点击 Assign。 

 

将地址修改为 dummy0 的首地址 0x4001_0000。 

 

回到 diagram 窗口，点击验证一下，没有错误，退出 block design。 
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二、 挂 IP 到 wujian100 

生成 IP 的 Wrapper。在 Source 里找到生成的 ahb_axi，右键 Generate Output 

Products 

 

再右键点击 Create HDL Wrapper。 

 

点击 OK。 
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可以看到生成了 wrapper，可以被调用，或者再加一层文件进行调用。 

 

给自己的 design 加一层顶层文件。点击+号，新建设计源文件。 

 

 Create File。File name 为 myio_top。点击 Finish。 
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 点击 OK，点击 Yes。 

 

 要将 main_dummy_top0 替换成 myio_top。在 myio_top 中例化 ahb_axi_wrappper，

并添加与原 dummy模块文件中相同的端口。 
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相关 RTL代码： 

module myio_top(haddr, hclk, hprot, hrdata, hready, hresp, hrst_b, hsel, hsize, htrans, hwdata,  

hwrite, hburst,//新增 

  intr, 

  myio//新增 

); 

output [31:0] myio; 

input   hburst; 

input   [31:0]  haddr;         

input           hclk;          

input   [3 :0]  hprot;         

input           hrst_b;        

input           hsel;          

input   [2 :0]  hsize;         
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input   [1 :0]  htrans;        

input   [31:0]  hwdata;        

input           hwrite;        

output  [31:0]  hrdata;        

output          hready;   

output  [1 :0]  hresp;     

output                intr;     

wire  [31:0]  hrdata;        

wire          hready;   

wire  [1 :0]  hresp;     

wire          intr; 

  

wire [2:0] hburst; 

wire hready_in; 

assign hready_in = hready; 

wire [31:0] myio;  

    

ahb_axi_wrapper u_ahb_axi_wrapper(//例化 ahb_axi_wrapper 模块 

   .AHB_INTERFACE_haddr      (haddr), 

   .AHB_INTERFACE_hburst     (hburst), 

   .AHB_INTERFACE_hprot      (hprot), 

   .AHB_INTERFACE_hrdata     (hrdata), 

   .AHB_INTERFACE_hready_in  (hready_in), 

   .AHB_INTERFACE_hready_out (hready), 

   .AHB_INTERFACE_hresp      (hresp), 

   .AHB_INTERFACE_hsize      (hsize), 

   .AHB_INTERFACE_htrans     (htrans), 

   .AHB_INTERFACE_hwdata     (hwdata), 

   .AHB_INTERFACE_hwrite     (hwrite), 

   .AHB_INTERFACE_sel        (hsel), 
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   .myio                     (myio), 

   .s_ahb_hclk               (hclk), 

   .s_ahb_hresetn            (hrst_b) 

); 

    

endmodule 

 

 

要将 main_dummy_top0 替换成 myio_top。依次修改 ahb_matrix_top，pdu_top，

wujian100_open_top 中的例化。 
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双击打开修改 ahb_matrix_top 文件 

 

找到 x_main_dummy_top0 的例化 
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将例化更改为 myio_top，注意： 

1.还要添加新增的 output 端口 myio，信号需要引出到最顶层，myio 

2.新增了 hburst,之前的 dummy空模块中未使用，这里需要加上。 

 

在改文件开始处，增加输出引脚和定义： 

更改 

增加 

增加 
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双击打开修改 pdu_top 文件 
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找到例化的 ahb_matrix_top，添加 myio 连接 

 

同样，增加输出引脚和定义 
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双击打开修改 wujian100_open_top 文件 

 

找到例化的 pdu_top，添加 myio 连接 
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同样，增加输出引脚和定义 

 

现在就实现了 IP 的挂载。 

在约束文件中添加对应功能的引脚，这里将 myio 的低 9 位连接到三色灯的 9 个

引脚上。 
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像之前的教程一样，综合，实现，再生成 BIT 文件，下载到开发板上。 
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三、 实现与验证 

在 CDK 中编写简单的程序验证功能。 
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附：xdc文件修改说明 

说明：修改 xdc 文件（即该芯片的约束文件），要配置成所用板子一致的 xdc 

需要的资料：开发板用户手册；wujian100 工程里的 xdc 文件 

 

1. 开发板用户手册重点阅读内容： 

1) 时钟： 

 

2) IO 口电压：不同开发板用的电压不一样 

 

设置电压的约束： 

set_property CONFIG_VOLTAGE 3.3 [current_design] ：全部设定电压为 3.3 

3) 引脚：以灯和开关为例子：
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4) Flash 

 

5) 接口： 
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两种接口区别： 

UART：是嵌入式开发所说的串口。通过它可以向设备烧写程序和调试程序。 

JTAG：用于设备调试，需要硬件支持。主要用于芯片内部测试，调试程序。可

以直接观察和修改寄存器和内存中的数据，方便找出程序中的问题。 

2. xdc 约束更改 

1) 时钟： 

  

set_property CLOCK_DEDICATED_ROUTE FALSE [get_nets PAD_JTAG_TCLK] 

这一句必须加上 

2) LED： 

注意这三列，对照开发板资料给的引脚改 

https://so.csdn.net/so/search?q=%E5%B5%8C%E5%85%A5%E5%BC%8F&spm=1001.2101.3001.7020


61 

 

 

3) 复位: 

 

4) UART JTAG： 

 

5) JTAG： 

 

6）SD 卡： 

 

注意这两列，对照开发板资料给的引脚改 

 

3.其他 
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这些根据自己板子的资源多少和想实现的功能改；比如只想实现点灯，那么这

些就可以全注释掉；但如果要实现 OLED，那先看自己板子有没有 OLED 的配

置，然后根据开发板手册改 xdc 里相对应的引脚； 

 

以下为移植到 A7 50T 的 xdc 代码： 

 

set_property IOSTANDARD LVCMOS33 [get_ports]   

 

#clock 

set_property -dict {PACKAGE_PIN N14 IOSTANDARD LVCMOS33} [get_ports clk] 

create_clock -period 20.000 -name sys_clk_pin -waveform {0.000 10.000} -add [get_ports clk] 

 

set_property CLOCK_DEDICATED_ROUTE FALSE [get_nets PAD_JTAG_TCLK] 

 

#LED 

set_property -dict {PACKAGE_PIN N16 IOSTANDARD LVCMOS33} [get_ports 

PAD_GPIO_0] 

set_property -dict {PACKAGE_PIN P15 IOSTANDARD LVCMOS33} [get_ports PAD_GPIO_1] 

set_property -dict {PACKAGE_PIN P16 IOSTANDARD LVCMOS33} [get_ports PAD_GPIO_2] 

 

#RESET button 

set_property PACKAGE_PIN L13 [get_ports PAD_MCURST] 

 

#USI0 
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set_property PACKAGE_PIN T7 [get_ports PAD_USI0_SCLK] 

set_property PACKAGE_PIN T8 [get_ports PAD_USI0_SD0] 

 

 

#JTAG 

set_property PACKAGE_PIN F12 [get_ports PAD_JTAG_TCLK] 

set_property PACKAGE_PIN F13 [get_ports PAD_JTAG_TMS] 

 

#SD card 

set_property PACKAGE_PIN L4 [get_ports { PAD_GPIO_6 }]; #Sch=sd_cclk         sclk        

PAD_GPIO_6 

set_property PACKAGE_PIN T2 [get_ports { PAD_GPIO_18 }]; #Sch=sd_cd          card detect 

set_property PACKAGE_PIN R1 [get_ports { PAD_GPIO_5 }]; #Sch=sd_cmd          mosi        

PAD_GPIO_5 

set_property PACKAGE_PIN H16 [get_ports { PAD_GPIO_7 }]; #Sch=sd_d[0]         miso        

PAD_GPIO_7 

set_property PACKAGE_PIN R2 [get_ports { PAD_GPIO_19 }]; #Sch=sd_d[3]        cs          

PAD_GPIO_19 

# set_property PACKAGE_PIN F12 [get_ports { PAD_GPIO_20 }]; #Sch=sd_reset       rst         

PAD_GPIO_20 

 

set_property CFGBVS VCCO [current_design] 
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